4Next Tip Sheets - MGBHC monitoring report

MGBHC Liaison Sorting Report

Liaisons tasked with monitoring referrals to Mass General Brigham Home Care can use the Liaison Sorting Report to
search for referrals, and then export the information to Excel. The information in Excel can be filtered to identify
referrals with potential missed visits, to manage referrals with an upcoming start of care (SOC), and to validate Expected
Discharge dates.

High-level steps

Pull the report into Excel and turn on filters

1. Click http://phsqlweb430/Reports/report/4Next2.0/Liaison%20Reports/LiaisonsSorting.

2. Set the parameters: Referral Source Type (All, MGB, nonMBG); Referral Source (one or more sites); Providers (one or
more from MGBHC and Spaulding sites)

Click the View button.

Click [E ~ to open the export drop-down menu, and then click the Excel option.

When prompted, click the Open button.

Click the Sort & Filter menu, and then click the Filter option.
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Finding potential missed visits
Only relevant cases that have an Actual Disch Date, but no SOC, ROC, or Revisit date, are shown on the report.
1. Clear allfilters.
2. Setfilters:
e Status column: Uncheck Select all; check Accept Offer, Finalized, Offered.
e Actual Disch Date: Uncheck Blanks (end of list).
e SOC: Uncheck Select All, and then check Blanks (end of list).
e ROC and Revisit Date: For both columns, uncheck Select All, and then check Blanks (end of list).
3. Sort the list A to Z in the PatientName column.
4. For each patient on the filtered list, please look at Discharge Summary on acute side. If indicated that patient went
home with Mass General Brigham Home Care, we need to secure the visit.

Finding next-day discharges with SOC that need registration and/or orders
Only relevant cases that have an SOC date, which are missing REG and/or ORD, are shown on the report.
1. Clear allfilters.
2. Setfilters:
e Status column: Uncheck Select all; check Accept Offer, Finalized, Offered.
e Actual Disch Date: Uncheck Select All and then check tomorrow’s date.
e SOC: Uncheck Blanks (end of list).
e Progress: Uncheck all that have both Reg and ORD.
3. Sort the list Ato Z in the PatientName column.
4. Add Finalized to Referrals Received filter. Find each patient in Referrals Received. As needed, Send to Admissions,
answer Yes to Orders Received.

Checking expected discharge dates

Only relevant cases that have no Actual Disch Date, but do have an Expected Disch Date, are shown on the report.
1. Clear all filters.

2. Setfilters:

e Status column: Uncheck Select all; check Accept Offer, Finalized, Offered.

e Actual Disch Date: Uncheck Select all, and then check Blanks (end of list).

e Expected Disch Date: Uncheck Blanks (end of list).

Sort the list A to Z in the PatientName column.

For each patient on the filtered list, check to see if the patient is going as planned.

5. If the expected discharge date is not correct, update the PAA on the Details view of the referral.
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Generating the report

1.

5.

Access the 4Next reporting portal: URL for production goes here

SQL Server Reporting Services

% Favorites [ Browse

LiaisonsSerting

(You must be on the network, either on-site or VPN, to run the report.)

Braidt, Trish 1.

Referral
Source
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- Referral
= Source
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-~ (MGB
" Non-
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Acute)

Click |*| to display Referral Source Type options, and then click to check which type(s) to look for. At least one source
is required to continue. (Checking Select All automatically checks off the other options.)

Referral
Source |.v.
Type |0 (Select All

[ MGE

T Non-MGE o

Referra
Source

Type

(Select All)
MGE
Nan-MGB

| v

Referra
Source

Type

|
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Click |*| to display Referral Source options, and then click to check which source(s) to look for. At least one source is
required to continue. (Checking Select All automatically checks off all the other options.)

Referral |\,F
Source | — ]
_) (Select All)
|0 Abbatt House

O Aberjona Mursing Center

[ Addison Gilbert Hospital

] Adult Day Health

O Albany Medical Center Hospita
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[) Mattapan Health and Rehab
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I Melroze Healthcars

[ Melrose Wakefield Hospital
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[ Merrimack Valley Hospital
[ Y P

-
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Source

|Brigham and Women's Faulkner Hos) | ¥/

Click |*| to display Providers options, and then click to check which MGB provider(s) to look for. At least one source is
required to continue. (Checking Select All automatically checks off all the other options.)
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Click | view Report | The report is displayed beneath the search parameters.
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Exporting the Report to Excel

Prowid I 1
Reharra - Faferral | 1 I'P:E!- o [ —H—Rem—l
Source | MGENon-MGE i | Brngiam and Women's Faulkner Hos | ¥ g MGEHC L]
r'ﬂ Sl e i L7 1] w J i sbuieinietivarieinlioiipirpsioteuriiniepplepilishetis | M- | bl
¥ Boute)
¥
4 € 1 Jer > Bl O ©  [w0% R 122 B= | Find | Nest
MASS GENMERAL ERIGHAM HOME CARE Messachuzells General Hospial MGHE12 E1208 B003555 admizsion, madicars
A
MASS GEMERAL BERIGHAM HOME CARE Massachusefls General Hospital mghe 12 B001184 amaze, six
MASS GENERAL BRIGHAM HOME CARE Magsachusetts General Hospaal mghal 5000543 amaze. Hiee
MASS GEMERAL BRIGHAM HOME CARE Massachusetts General Hospaal Fgh emer S006996 amaze b
MASS GENERAL BERIGHAM HOME CARE Massachusetts General Hospaal mgh adm pool S002730 approved parson, gid
MASS GENERAL BRIGHAM HOME CARE Massachusetts General Hospdal MGH L10 L1014 2003332 atheazerconazec
A eplcpricopy downhventytwenty
MASS GENERAL BRIGHAM HOME CARE Massachusetts General Hospdal mgh wid 8005268 atcinfourthrasfour
eplcprdcopy downbaentybaenty
MASS GENERAL BRIGHAM HOME CARE Brigham and Wemen's Hospital CARDS10W 47405229 aicinfowrthraethnes
1028-1 epiCpIACOpy Snmtaantyhuanty
MASS GEMERAL ERIGHAM HOME CARE Massachuselts General Hospaal MGH E16 8006877 atplzensonaninag
E1602 A spitprdcopy Sowntwgntyhwinty
MASS GEMERAL ERIGHAM HOME CARE Brigham and Yomen's Faulkner Hospital owinurgn 80127174 bedicosad,
MASS GEMERAL ERIGHAM HOME CARE Brigham and Yomen's Hospital mchem4d 97432843 beacon, amanda
MASS GEMERAL BRIGHAM HOME CARE Brighaem and Womnen's Hospital HEMONCTD GT460944 bidsade. bah
T8-1
=
k

Report of referrals from BWFH, BWH, and MGH to Mass General Home Care

If you haven’t already, generate the report.

Click &l ~ to open the export drop-down menu, and then click the Excel option. (It's second on the list.)

3. The Downloads popup opens in the upper right. (If it ext20/Stat%e2.. A @ g q & lo
closes before you get to the next step, click ‘l’n')
{ Downloads P Qe
o What do you want to do with LiaisonsSorting xls...
Open Save as v
4. Click the Open button. The report opens in Excel.
£ Search (Alt+Q)

File Home Insert Page Layout Formulas Data Review View Help  Acrobat 1 Comments =7 Share
I’j’j Al Jo A A EIE = e General | | [EH Conditional Formatting v Hinsert ~ > v v @
b My~ $ % 9 B Format as Table ¥ X Delete ~ B O~ Anale

& = = = = .

e . I U~ O A :E: E=EHY @ 2 cell Styles ~ fHiFormaty | &~ Datn
Clipboard 1§ Font & Alignment B Number & Styles cells Editing Analysis | Sensitivity ~
B2 - I Referred To v

I B L C A
2

MASS GENERAL BRIGHAM HOME CARE Brigham and Women's Hospital CARDS10W ™ 97405229 alclnfounhreethree
3 1029-1 prdcopy ty
4 | MASS GENERAL BRIGHAM HOME CARE Brigham and Women's Hospital mchemdb " 97432843 beamn amanda

MASS GENERAL BRIGHAM HOME CARE Brigham and Women's Hospital HEMONC7D 78-7 97469944 bedside, bwh
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Turning on filters in Excel
1.

£ Search (Alt+Q)

If you haven’t already, generate the report and then export into Excel. The Home options are shown by default.

File Insert  Page Layout Formulas Data Review View Help  Acrobat 1 Comments & Share
I’i—‘n X rial 10 A A —— General | | Bl conditional Formatting ~ HHinsert ~ >~ QV -
PEE &~ _ : $ v % 9 B Format as Table ~ X Delete ~ v PO i
- I U-|H- &A= = b [iZZ Cell Styles v =] Format ~ &~ Data
Clipboard & Font N Alignment [ Number [ Styles Cells Editing Analysis Sensitivity ~
B2 - f Referred To v
1 B 1 C Il D 1 E Il F 1 =
1 Referred To Referred From PatientMRN PatientName .
|2 SsssSSLSLSSSS——S—S—S—“_“_—_—_—__—_—_—_—_———————mmsssssanhShhssEEhERBRaD—sssm——msSsSsSsss——amaLahnhnhhhShSSssssnhhnmhhohhhhhhhhhaagggggaanhahhhaogghggggaaewaa |

2. Clickthe 5%~ button in the Editing section. (If your Excel window is big enough, the button is labeled Sort & Filter.)

£ Search (AIt+Q)

Braidt, Trish J.

File Home Insert Page layout Formulas Data Review View Help Acrobat 1 Comments 2 Share
fﬂ X Arial 10 A A Ej — % 0 General +| | [ conditional Formatting ~ HHinsert ~ > QVV
~ v = v 2 —
Pasg [‘B - — _ — $ v~ % 9 [ Format as Table BX Delete ~ Analyze
s B I Uv Hy &0vA. ZIE=E == M 7 Cell Styles ~ [ Format~ | &~ Data
Clipboard [ Font ] Alignment [ Number ] Styles Cells Editing Analysis Sensitivity ~
3. Click the Filter option.

27| [@]
il SortAtoZ
2] sortZtoA
Custom Sort...
57
L=

4. Adrop-down arrow is added to every column heading.
File Home Insert Page layout Formulas Data Review View Help Acrobat U Comments = Share
[ A Catibri = o da w | = General ~ | B conditional Formatting ~ Hinsert ~ o~ ;V"
F—;;E] Da o = o $ ~9% 9 @Furmat as Table » S’E[)elete - - p‘- Analr:
= e BZ Ui |~ i 1= ] [ cell Styles ~ [t Format ~ &~ Data
Clipboard R Font ] Alignment [} Number (] Styles Cells Edliting Analysis Sensitivity ~
Al - e v
Referred To Referred From Location PatientMr " PatientName
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Finding potential missed visits

1. If you haven’t already, generate the report, export into Excel, and then turn on filters.
File Home Insert Page Layout Formulas Data Review View Help Acrobat - Comments 5 Share
s ting ~ v v
1 X i . JA | = =Ee. ® General « | [ conditional Formatting & insert pI - 2 @
'-};Ei[h. b n - _.-: _/ B $ v % 9 [EErormatasTable v B Delete ~ | [T]~ O~ Ag-
- & B I U H-| &~ A == = == | B .0 G2 Cell Styles ~ [ Format~ | &~ Da:‘a
Chipboard i Font F Alignment L Number & Styles Cells Editing Analysis Sensitivity ~
Al f v
Referred To Referred From Location . PatientMr-"
9 MASS GENERAL BRIGHAM HOME CARE trigham and Women's Hospital bwp 26638 1, test
2. Ifyou applied other filters already for a different task, clear them by clicking |47 .
the Clear option on the Sort & Filter menu on the Edits section. Al sortAtoZ
Z] sotztoA
Custom Sort...
Filter
E Reapply
3. Scroll by clicking and dragging the horizontal scrollbar handle (highlighted below) to the right. =
LiaisonsSorting ) 0]
Ready @ r‘@DlsplaySemngs ﬁ E -—F——+ 100%
4. Watch the column headings. Stop scrolling when you can see the Status column (T).
| Q . R . s T U . \
Revisit Date Progress Status Case Owner Primary/Dischargg
2 > > - = M Diagnosis
5. Click |~ in the Status column. 2] sotAtoz 2] sotatwz
The Sort & Filter menu opens. Z| sotZtoA Z] sotztoA
6. Click to uncheck the [+ (Select All) option. Sart by Color > Sort by Color >
7. Click to check the following options: Sheet View > Sheet View >
<7 S7
e Accept Offer (by the sender)
e Finalized (by the sender) _ _
Text Filters > Text Filters >
e Offered (by MGBHC) S Jo e o
8. Click the OK button. —Faned
. . . CTACCeptoe | Accept Offer |
The column is flagged to show that it’s filtered: ¥ Canceled S——
Status MmEaer
| Offered
The report shows only referrals where MGBHC is i Retracted i Retracted
. . i.[¥ Sent .1 Sent
offering to take the patient, or the sender has
accepted or finalized the offer.
Cancel Cancel

Continued on next page
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9. Scroll back by clicking and dragging the horizontal scrollbar handle (highlighted below) to the left. G
10. Watch the column headings. Stop scrolling when you can see the dates, in columns L through Q:

L M N (0] p Q
| Admit Date |Expected Disch Date |Actual Disch Date E Revisit Date

11. Click | = |in the Actual Disch Date column. 21 sort Oldest to Newest
The Sort & Filter menu opens. Z | sort Newest to Oldest
12. If needed, scroll down to the bottom of the list. "
ort by Color >
13. Click to uncheck the [¥| (Blanks] option.
14. Click the OK button.
The column is flagged to show that it’s filtered: y
Actual Disch Date
Date Filters >
Only relevant cases that have an Actual Disch Date e 2
are shown on the report. [ :,.:;250"2';‘“‘”’
| ¥ December
“o9
¥10
Cancel

15. Click |~ |in the SOC column. The Sort él Sort Oldest to Newest ?l Sort Oldest to Newest
& Filter menu opens. Z 1 sort Newest to Oldest Z1 sort Newest to Oldest
16. Click to uncheck the Sort by Color > Sort by Color >
[+ (Select All) option. (This unchecks > >
all the dates, as well as the Blanks 57 7
option.) . N
17. If needed, scroll down to the bottom Date Filters N Date filters N
18 (():T'tﬂi IIStr; O Blanks) Search (All) o Search (All) O
. Click to check LI (Blanks).
) ¥ (Select All) | (Selcct All
19. Click the OK button. = ciJ-D
The column is flagged to show that it’s . 54 December =] December
f|t d: 10 |:| 10
Ilerec: N A A -0

soc M3 ﬁ
L.[¥ (Blanks) I--D (Blanks

Only relevant cases that have an Actual
Disch Date, but no SOC date, are shown cancel Cancel
on the report.

Continued on next page
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20. Click | ~ |in the ROC column. The Sort
& Filter menu opens.

Click to uncheck the

[+ (Select All) option. (This unchecks
all the dates, as well as the Blanks
option.)

If needed, scroll down to the bottom
of the list.

23. Click to check [ (Blanks).

24. Click the OK button.

The column is flagged to show that it’s

filtered:
ROC

21.

22.

Only relevant cases that have an Actual
Disch Date, but no SOC date, that are not
ROCs, are shown on the report.

25. Click | ~ |in the Revisit Date column.
The Sort & Filter menu opens.

Click to uncheck the

¥ (Select All) option. (This unchecks
all the dates, as well as the Blanks
option.)

If needed, scroll down to the bottom
of the list.

28. Click to check [ (Blanks).

29. Click the OK button.

The column is flagged to show that it’s

filtered:
Revisit Date

Only relevant cases that have an Actual
Disch Date, but no SOC date, that are not
ROCs or revisits, are shown on the report.

26.

27.

30. Scroll back by clicking and dragging the horizontal scrollbar handle (highlighted below) to the left.

;l Sort Oldest to Newest 91 Sort Oldest to Newest
il Sort Newest to Oldest il Sort Newest to Oldest
Sort by Color > Sort by Color >
<7 S7
Date Filters > Date Filters P
Search (All) ,Ov Search (All) ,Ov
W (Select All)
e 2022
= [¥ December =] December
¥ 10 010
11 111
13 mEE
[¥ (Blanks) I [ (Blanks
;,L Sort Oldest to Newest ?l Sort Oldest to Newest
il Sort Newest to Oldest zAl Sort Newest to Oldest
Sort by Color > Sort by Color b
57 S$7
Date Filters > Date Filters b4
Search (All ,Ov Search (All) pv
¥ (Select All) W (Select All)
S0 =0 2022
=¥ December =] December
10 C1o
¥ 11 111
v13 !
¥l (Blanks) [ {Blanksl
&

31. Watch the column headings. Stop scrolling when you can see the PatientName column (F).

m-m-mn
2
4 | mghe12 8001184 amaze, six 07/07/1986 self
35: mcpoBa 97419162 epictest, lindseybwh 03/18/1989 self franklin ma” 02038
75: bwhmcekg 08942385 oe-test, bilbo 01/01/1960 self everett ma” 02149
1 mgh case r 8002383 optime, insurance 12/25/1980 anchorage Ak 98515
81 management
| bwh care” 97446298 pasta, raviol 04/12/1989 self queens village nNy” 11427
82 | coordination
84: periop r 8009785 prismweb, casefour 09/27/1995 self medford ma” 02155
1 mgh case r 8000127 radvalidate, elsa 09/14/1965 blue cross blue shield somerville MA” 02145
100/ management
121 bwpvasrw” 26638197 test, test 01/01/1990 united healthcare natick ma” 01760
Continued on next page
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32. Click the blue PatientName column heading;
it will be outlined in green.

33. Click the Sort & Filter menu, and then click
the option to Sort A to Z.

PatientName

admission, medicare

amaze, six

Al SortZto A

Custom Sort...

87| Eitter

34. For each patient on the filtered list, please look at Discharge Summary on acute side. If indicated that patient went

home with Mass General Brigham Home Care, we need to secure the visit.

)
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Finding next-day discharges with SOC that need registration and/or orders

1. If you haven’t already, generate the report, export into Excel, and then turn on filters.
File Home Insert Pagelayout Formulas Data Review View Help Acrobat I Comments = Share
.«s[,i X v Jn YA K| = =Ee- 2 General « | [ conditional Formatting ~ Hinsert v pI - 2 i@;
b - - -: o $ v % 9 [EErormatasTable v B Delete ~ | [T]~ O~ R
- & B I U H-| &~ A == = == | B .0 G2 Cell Styles ~ [ Format~ | &~ Data
Chipboard i Font F Alignment L Number & Styles Cells Editing Analysis Sensitivity ~
Al f v
Referred To Referred From Location . PatientMr-"
9 MASS GENERAL BRIGHAM HOME CARE trigham and Women's Hospital bwp 26638 1, test
2. Ifyou applied other filters already for a different task, clear them by clicking &% .
the Clear option on the Sort & Filter menu on the Edits section. 8] sotAtoZ
Z] sotzZtoa
Custom Sort...
Eilter
Y& Reapply
3. Scroll by clicking and dragging the horizontal scrollbar handle (highlighted below) to the right. =
LiaisonsSorting @
Ready [® [& pisplay Settings i3] Mmoo+
4. Watch the column headings. Stop scrolling when you can see the Status column (T).

5. Click| = in the Status column.
The Sort & Filter menu opens.

6. Click to uncheck the [+ (Select All) option.
7. Click to check the following options:

e Accept Offer (by the sender)

e Finalized (by the sender)

e Offered (by MGBHC)
8. Click the OK button.

The column is flagged to show that it’s filtered:

Status

| Q | i | i
2 - -

The report shows only referrals where MGBHC is
offering to take the patient, or the sender has

accepted or finalized the offer.

Continued on next page

==
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Status

Case Owner

Ml Diagnosis

2l sortatoz
Zl sotztoa
Sort by Color

Sheet View
57

Text Filters

Search

¥ Retracted

- (Select All)

2l sortatoz
Zl sotztwoa
Sort by Calor

Sheet View
v

Text Filters

Search

e o
-] Accept Offer
T Calceied

[ Offered
LI Retracted
[ sent

L[¥ Sent
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9. Watch the column headings. Stop scrolling when you can see the dates, in columns L through Q:

| L , M , N , o , p , Q |
| Admit Date |Expected Disch Date |Actual Disch Date E Revisit Date

)

10. Click| ~ | in the Actual Disch Date column. 21 sort Oldest to Newest 21 sort Oldest to Newest
The Sort & Filter menu opens. Z| Sort Newest to Oldest Z] Sort Newest to Oldest
11. Click to uncheck the [+ (Select All) option. (This Sort by Color > Sort by Color >
unchecks all the dates, as well as the Blanks
option.)
12. If needed, scroll down the list to find
tomorrow’s date. Date Filters ] Date Filters >
13. Click to check [ for tomorrow’s date (12/13 in Search (All Jer Search (All) Jor
example). B Sclect AlD)
. L 0 2022
14. Click the OK button. = December — ] December
. T . 410 1o
The column is flagged to show that it’s filtered: @11
Actual Disch Date 213
[ (Blanks) (Blanks)
Only relevant cases that have an Actual Disch Date = p—
are shown on the report.

15. Click | = |in the SOC column. The Sort & Filter 41 sort Oidest to Newest
menu opens. 2| Sort Newest to Oldest
16. If needed, scroll down to the bottom of the list. Sort by Color 4
17. Click to uncheck the [# (Blanks! option.
18. Click the OK button.
The column is flagged to show that it’s filtered: Date filters >
soc ov
[ (Setect A
51 2022
=1C4 December
0
10

Now you have a list of patients, whose Actual Disch date is tomorrow (12/13/2022 in this example), who have a SOC

date.
T“ Admit Date Expected Disch Date Ac'tual Disch Date -- Revisit Date 1

A" 02038 12/5/2022 12/12/2022 12/13/2022
11427 12/11/2022 12/12/2022  12/13/2022

38 franklin

queens village NY '

82
r

somerville MA 02145 12/1/2022 12/12/2022  12/13/2022

19. Scroll by clicking and dragging the horizontal scrollbar handle to the right. =
20. Watch the column headings. Stop scrolling when you can see Progress, in column S:

Q | R I s I T | u
Service

Revisit Date i Case Owner Primary/Discharge
z = -] M Diagnosis
38 PT

Olivia Bedard Knee replacemen
Continued on next page
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. Click | = |in the Progress column. The

Sort & Fi |t Al Sort Oldest to Newest zl Sort Oldest to Newest
or ilter menu opens.
Sort Newest to Oldest Sort Newest to Oldest
22. Uncheck any box that has both REG Al sortNew Al sortew
and ORD. Scroll down if need, to Sort by Color ’ Sort by Color ’
review every item ' '
23. Click the OK button. ¥ ¥
Y Y
The Progress column is flagged as Text Filters N Text Filters N
filtered:
Progress /O

All active and finalized cases with an
actual discharge date and an SOC for
tomorrow, that are missing REG, ORD, or
both REG and ORD, are shown in the
report.

E L

97446298 pasta, ravioli 04/12/1989 self queens vll\age y" 11427 12/11/2022

[+]

82

8000127 radvalidate, elsa 09/14/1965 blue cross blue shield somerville mA” 02145 12/1/2022
100
136 97458509 upgtttwoninesixthree, epichom 01/29/1985 harvard pilgrim braintree MA" 02184 11/15/2022

146

25. Click the blue PatientName column heading;

it will be outlined in green. SationtName
26. Click the Sort & Filter menu, and then click _
the option to Sort A to Z. admission, medicare

amaze, six al SortZto A

]
1
1
1
1
T
1
i
Custom Sort...

Filter

<57

52

27. Go to 4Next Referrals Received list and add the Finalized filter.

For each patient on the report, check the referral on the Referrals Received list.

e If Orders Received on the checklist is not checked:
a. ClickNo J® to turn the switch to . Yes.
b. Click the save button.

e If the SEND TO ADMISSIONS button is active (blue) and there is no time stamp indicating the date and time the
referral actually went into Epic, click the SEND TO ADMISSIONS button.

o [f the SEND TO ADMISSIONS button is inactive (gray), but there’s no date, the referral was sent and is waiting in a
gueue. Once it actually goes into Epic, the timestamp will appear, and the REG indicator will appear in the
Progress column in Referrals Received. Next time you run the report, REG will appear in the Progress column.

)
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Checking expected discharge dates

1.

Referred To

9 MASS GENERAL BRIGHAM HOME CARE

File Home Insert Page Layout Formulas
s

E'i A Calibri 11 v A A
Llim
Paste

S B I U~ H~ A
Chpboard C Font
Al f

Data

If you haven’t already, generate the report, export into Excel, and then turn on filters.

Referred From

trigham and Women's Hospital

D Search (Alt+Q)
Review View Help Acrobat
= §,/ = 2, General - E Conditional Formatting >
= $~%"9 [ Format as Table ~
= = 2= R G2 Cell Styles ~
Alignment ] Number 1] Styles

Location

J Comments 5 Share
Insert v v g E
E nsert Z z @!
2% Delete - O~
= Analyze
@forma! i 0 £ Data
Cells Editing Analysis | Sensitivity ~

. PatientMr"

2. If you applied other filters already for a different task, clear them by clicking

the Clear option on the Sort & Filter menu on the Edits section.

Ay~
21 sortAtoz
Z] sotzZtoa

Custom Sort...

Eilter

Y& Reapply

3. Scroll by clicking and dragging the horizontal scrollbar handle (highlighted below) to the right.

=

LiaisonsSorting

®
®

Ready

r‘q. Display Settings

H B O -——-

4. Watch the column headings. Stop scrolling when you can see the Status column (T).

[]

100%

5. Click| = in the Status column.
The Sort & Filter menu opens.

6. Click to uncheck the [+ (Select All) option.

7. Click to check the following options:

e Accept Offer (by the sender)

e Finalized (by the sender)
e Offered (by MGBHC)
8. Click the OK button.

The column is flagged to show that it’s filtered:

Status

. Q | B | &
2 v v

The report shows only referrals where MGBHC is
offering to take the patient, or the sender has

accepted or finalized the offer.

Continued on next page
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Status

Case Owner

v
Primary/Dischargd
M Diagnosis

2] sortAtwz
Z]l sotztoa
Sort by Color

Sheet View
<7

Text Filters

)

Canceled
¥ Denied

¥ Finalized
Offered

¥ Retracted
[ Sent

Cancel

21 sortatoz
Z] sartZtoa
Sort by Color

Sheet View
7

Text Filters

Search

[ lroolort A
- Accept Offer

Cancel

Page 12 of 14

@ 2023 Mass General Brigham Incorporated. All Rights Reserved



. 4Next Tip Sheets - MGBHC monitoring report

. Scroll by clicking and dragging the horizontal scrollbar handle to the left.
10. Watch the column headings. Stop scrolling when you can see the dates, in columns L through Q:

=

11. Click ' = in the Actual Disch Date

| L | M | N | (0] | P | Q |
| Admit Date |Expected Disch Date |Actual Disch Date “ Revisit Date

column. The Sort & Filter menu
opens.

12. Click to uncheck the
(Select All) option. (This unchecks
all the dates, as well as the Blanks
option.)

13. If needed, scroll down to the bottom
of the list.

14. Click to check [ (Blanks).

15. Click the OK button.

The Actual Disch Date column is flagged

as filtered:
Actual Disch Date

All relevant cases that do not have an
Actual Disch Date are shown on the
report.

él Sort Oldest to Newest

ﬁl Sort Newest to Oldest

Ql Sort Oldest to Newest

il Sort Newest to Oldest

16. Click | = | in the Expected Disch Date
column. The Sort & Filter menu opens.

17. If needed, scroll down to the bottom of
the list.

18. Click to uncheck the [v| (Blanks) option.

19. Click the OK button.

The column is flagged to show that it’s

filtered:

Expected Disch Date

All relevant cases that do have an Expected
Discharge Date are shown on the report.

Note: To focus on expected discharges for
today, uncheck Select All, and then check off
today’s date.

Sort by Color > Sort by Calor >
N N
7 57
N N
Date Filters > Date Eilters >
Search (All) por Search (All) o
vl (Select All é--D (Select All)
Elv2022 202022
- = December E|E| December
. (Blanks)
Cancel Cancel
21 sortatz 21 sertatoz
z
2] sortztoa Zl sortztoA
Sort by Color > Sort by Color >
N
[
N
Text Filters > Text Filters >
Search (All) /OV Search (All) pv
- (Select All) (¥ (Select All)
=¥ 2022 =¥ 2022
=¥ December | & December
12 é12
-13 ¥13
v 14 14
_[v 1¢ AT
-[¥ (Blanks)

02/25/2021

01/08/2021

r

ma 02115 09/22/2020

11

J K L M N
E Admit Date |Expected Disch Date |Actual Disch Date
2 - - - J x

12/13/2022
12/14/2022

12/12/2022

12/14/2022

Continued on next page
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20. Scroll to see the PatientName column (F), by clicking and dragging the horizontal scrollbar handle to the left.

11

21
22
23
25
26

47

50

E F G H | ] K L |~
8003695 admission, medicare 02/22/1931 medicare 02/25/2021
8006996 amaze, two 02/14/1978 self 01/08/2021
8006877 atplzeroonenine, 06/10/1986 self boston ma” 02115 09/22/2020
epicprdcopydowntwentytwenty
97428296 bwh, epictst 09/08/1967 02/27/2022
97436133 bwh, fiftyfive 02/02/1978 self somerville ma” 02143 02/26/2021
97436125 bwh, fiftyfour 01/01/1965 self somerville ma’ 02143 02/26/2021
97436141 bwh, fiftysix 03/03/1980 self somerville ma’ 02143 02/26/2021
97436117 bwh, fiftythree 02/02/1950 blue cross blue shield somerville ma” 02143 02/26/2021
97481758 fnext, confirmedpretwo 10/19/1995 self
8001701 fnextperf, hsix 10/11/1985 blue cross blue shield boston mA” 02115 03/08/2022
8008832 hodrover, test 01/01/2010 self boston MA" 02111 05/13/2022
-]
LiaisonsSorting | [©) [4] ] ]

21. For each patient on the filtered list, check to see if the patient is going as planned.

Check the most recent nursing and MD notes in Epic, which should give an indication if patient is going.
For expected discharges for today, if the nursing and MD notes aren’t clear, contact the patient’s nurse via
Voalte to ask if the patient is going as planned.

22. If the expected discharge date is not correct, go to the 4Next Referrals Received list, and add the Finalized filter.
Update the PAA on the Details view of the referral. See Completing the PAA.

Mass General Brigham

Page 14 of 14

@ 2023 Mass General Brigham Incorporated. All Rights Reserved


https://clinicalhelp.partners.org/4Next/requests-entity-referral-sections.htm

	MGBHC Liaison Sorting Report
	High-level steps
	Generating the report
	Exporting the Report to Excel
	Turning on filters in Excel
	Finding potential missed visits
	Finding next-day discharges with SOC that need registration and/or orders
	Checking expected discharge dates

